MTS4EAV7
HEVC / AVC Video and Compressed Audio Analyzer

Installation and Safety Instructions

O RO O O AR Tektronix
071-3435-00 Ve






MTS4EAV7
HEVC / AVC Video and Compressed Audio Analyzer

Installation and Safety Instructions

Register now!

Click the following link to protect your product.

» www.tektronix.com/register

This document supports software version 7.1.2 and above.

www.tektronix.com Tektronix
074-3435-00 s


http://www.tek.com/register

Copyright © Tektronix. All rights reserved. Licensed software products are owned by Tektronix or its subsidiaries
or suppliers, and are protected by national copyright laws and international treaty provisions.

Tektronix products are covered by U.S. and foreign patents, issued and pending. Information in this publication
supersedes that in all previously published material. Specifications and price change privileges reserved.

TEKTRONIX and TEK are registered trademarks of Tektronix, Inc.

"Dolby", "Pro Logic", and the double-D symbol are trademarks of Dolby Laboratories.

Contacting Tektronix

Tektronix, Inc.

14150 SW Karl Braun Drive
P.O. Box 500

Beaverton, OR 97077

USA

For product information, sales, service, and technical support:
= In North America, call 1-800-833-9200.
= Worldwide, visit www.tektronix.com to find contacts in your area.


http://www.tektronix.com/contact

Warranty

Tektronix warrants that the media on which this software product is furnished and the encoding of the programs on
the media will be free from defects in materials and workmanship for a period of three (3) months from the date of
shipment. If any such medium or encoding proves defective during the warranty period, Tektronix will provide

a replacement in exchange for the defective medium. Except as to the media on which this software product is
furnished, this software product is provided “as is” without warranty of any kind, either express or implied.
Tektronix does not warrant that the functions contained in this software product will meet Customer's requirements
or that the operation of the programs will be uninterrupted or error-free.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration
of the warranty period. If Tektronix is unable to provide a replacement that is free from defects in materials and
workmanship within a reasonable time thereafter, Customer may terminate the license for this software product
and return this software product and any associated materials for credit or refund.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY
OTHER WARRANTIES, EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
TEKTRONIX' RESPONSIBILITY TO REPLACE DEFECTIVE MEDIA OR REFUND CUSTOMER'S
PAYMENT IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH
OF THIS WARRANTY. TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT,
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX
OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.

[W9b — 15AUG04]



IMPORTANT: READ BEFORE OPERATING EQUIPMENT

This software is provided under license from Tektronix, Inc. Retention of this program for more than thirty (30)
days or use of the program in any manner constitutes acceptance of the license terms.

CAREFULLY READ THE ENCLOSED SOFTWARE LICENSE AGREEMENT. If you cannot agree to the license terms,
promptly contact the nearest Tektronix Field Office for return assistance.

TEKTRONIX SOFTWARE LICENSE AGREEMENT

THE PROGRAM, OR PROGRAMS, ENCODED OR INCORPORATED WITHIN EQUIPMENT, IS
FURNISHED SUBJECT TO THE TERMS AND CONDITIONS OF THIS AGREEMENT. RETENTION OF
THE PROGRAM FOR MORE THAN THIRTY DAYS OR USE OF THE PROGRAM IN ANY MANNER
WILL BE CONSIDERED ACCEPTANCE OF THE AGREEMENT TERMS. IF THESE TERMS ARE NOT
ACCEPTABLE, THE UNUSED PROGRAM AND ANY ACCOMPANYING DOCUMENTATION SHOULD
BE RETURNED PROMPTLY TO TEKTRONIX FOR A FULL REFUND OF THE LICENSE FEE PAID. (FOR
INFORMATION REGARDING THE RETURN OF PROGRAMS ENCODED OR INCORPORATED WITHIN
EQUIPMENT, CONTACT THE NEAREST TEKTRONIX SALES OFFICE.)

DEFINITIONS. "Tektronix" means Tektronix, Inc., an Oregon corporation, or local Tektronix’ legal entity that is
supplying the equipment.

"Program" means the Tektronix software product (executable program and/or data) enclosed with this Agreement
or included within the equipment with which this Agreement is packed.

"Customer" means the person or organization in whose name the Program was ordered.

LICENSE. Customer may:
1. Use the Program on a single machine at any one time;

2. Ifthe Program is provided in connection with a floating-user license, the Program may be used on multiple
machines provided that the user is authorized, and the total number of users at any one time does not exceed
the total number of licensed concurrent users;

3. Modify the Program or merge it with another for use on the single machine; and

4. Copy the Program for archival or backup purposes, provided that no more than one (1) such copy is permitted
to exist at any one time. If the Program is provided in connection with a floating-user license, the Program may
be copied onto multiple machines for use by authorized users.

Each copy of the Program made by Customer must include a reproduction of any copyright notice or restrictive
rights legend appearing in or on the copy of the Program as received from Tektronix.

Customer may not:

1. Use the Program on more than one machine at any one time, unless covered by a floating-user license
or separate site license;

2. Transfer the Program to any person or organization outside of Customer or the corporation of which Customer
is a part without the prior written consent of Tektronix, except in connection with the transfer of the equipment
within which the programs are encoded or incorporated;



3. Export or re-export, directly or indirectly, the program, any associated documentation, or the direct product
thereof, to any country to which such export or re-export is restricted by law or regulation of the United States
or any foreign government having jurisdiction without the prior authorization, if required, of the Office of
Export Administration, Department of Commerce, Washington, D.C. and the corresponding agency of such
foreign government;

4. For object-code Programs only, reverse compile or disassemble the Program for any purpose; or
5. Copy the documentation accompanying the Program.

For Programs designed to reside on a single-machine and support one or more additional machines, either locally
or remotely, without permitting the Program to be transferred to an additional machine for local execution, the
additional machines shall be considered within the definition of "single machine". For programs permitting the
Program to be transferred to an additional machine for local execution, a separate license shall be required for
each such machine with which the Program may be used, or each concurrent user authorized under a floating-user
license.

Title to the Program and all copies thereof, but not the media on which the Program or copies may reside, shall be
and remain with Tektronix or others for whom Tektronix has obtained a respective licensing right.

Customer shall pay when due all property taxes that may now or hereafter be imposed, levied or assessed with
respect to the possession or use of the Program or this license and shall file all reports required in connection with
such taxes.

Any portion of the Program modified by Customer or merged with another program shall remain subject to
these terms and conditions.

If the Program is acquired by or for an agency of the U.S. Government, the Program shall be considered computer
software developed at private expense and the license granted herein shall be interpreted as granting Customer
restricted rights in the Program and related documentation as defined in the applicable acquisition regulation.

THE PROGRAM MAY NOT BE USED, COPIED, MODIFIED, MERGED, OR TRANSFERRED TO
ANOTHER EXCEPT AS EXPRESSLY PERMITTED BY THESE TERMS AND CONDITIONS.

UPON TRANSFER OF ANY COPY, MODIFICATION, OR MERGED PORTION OF THE PROGRAM, THE
LICENSE GRANTED HEREIN IS AUTOMATICALLY TERMINATED.

TERM. The license granted herein is effective upon acceptance by Customer, and shall remain in effect until
terminated as provided herein. The license may be terminated by Customer at any time upon written notice to
Tektronix. The license may be terminated by Tektronix or any third party from whom Tektronix may have obtained
a respective licensing right if Customer fails to comply with any term or condition and such failure is not remedied
within thirty (30) days after notice hereof from Tektronix or such third party. Upon termination by either party,
Customer shall return to Tektronix or destroy, the Program and all associated documentation, together with

all copies in any form.

LIMITED WARRANTY. Tektronix warrants that the media on which the Program is furnished and the encoding of the
Program on the media will be free from defects in materials and workmanship for a period of three (3) months
from the date of shipment. If any such medium or encoding proves defective during the warranty period, Tektronix
will provide a replacement in exchange for the defective medium. Except as to the media on which the Program is
furnished, the Program is provided "as is" without warranty of any kind, either express or implied. Tektronix does
not warrant that the functions contained in the Program will meet Customer's requirements or that the operation
of the Program will be uninterrupted or error-free.



In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration
of the warranty period. If Tektronix is unable to provide a replacement that is free from defects in materials and
workmanship within a reasonable time thereafter, Customer may terminate the license for the Program and return
the Program and any associated materials for credit or refund.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PROGRAM IN LIEU OF ANY
OTHER WARRANTIES, EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
TEKTRONIX' RESPONSIBILITY TO REPLACE DEFECTIVE MEDIA, OR REFUND CUSTOMER'S
PAYMENT IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH
OF THIS WARRANTY.

LIMITATION OF LIABILITY, IN NO EVENT SHALL TEKTRONIX OR OTHERS FROM WHOM
TEKTRONIX HAS OBTAINED A LICENSING RIGHT BE LIABLE FOR ANY INDIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES ARISING OUT OF OR CONNECTED WITH
CUSTOMER'S POSSESSION OR USE OF THE PROGRAM, EVEN IF TEKTRONIX OR SUCH OTHERS
HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.

THIRD-PARTY DISCLAIMER. Except as expressly agreed otherwise, third parties from whom Tektronix may have
obtained a licensing right do not warrant the program, do not assume any liability with respect to its use, and do not
undertake to furnish any support or information relating thereto.

GENERAL. This Agreement contains the entire agreement between the parties with respect to the use, reproduction,
and transfer of the Program.

Neither this Agreement nor the license granted herein is assignable or transferable by Customer without the
prior written consent of Tektronix.

This Agreement and the license granted herein shall be governed by the laws of the state of Oregon.

All questions regarding this Agreement or the license granted herein should be directed to the nearest Tektronix
Sales Office.

ADDITIONAL LICENSE GRANT FOR VIDEO TEST SEQUENCES. The Software Product may include certain test
patterns, video test sequences and video clips (together “Video Test Sequences”). If so, the following terms
describe Your rights to the Video Test Sequences:

You may use, copy and modify the Video Test Sequences and display or distribute copies of individual Video Test
Sequences in connection with Your video testing activity.

You are not licensed to do any of the following:

1. You may not distribute the collection of Video Test Sequences, except in connection with the sale of original
equipment containing the Video Test Sequences, without prior written permission from Tektronix.

2. You may not distribute the collection of Video Test Sequences, except in connection with the sale of original
equipment containing the Video Test Sequences, without prior written permission from Tektronix.



3. You may not sell, license or distribute copies of the Video Test Sequences on a standalone basis or as part of any
collection, product, or service where the primary value of the product or service is the Video Test Sequences.

You must indemnify, hold harmless, and defend Tektronix from and against any claims or lawsuits, including
attorneys’ fees, that arise from or result from the use or distribution of Video Test Sequences as modified by You.

You must include a valid copyright notice on Your products and services that include copies of the Video Test
Sequences.
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Compliance information

Compliance information

Environmental considerations

This section provides information about the environmental impact of the product.

Product end-of-life  Observe the following guidelines when recycling an instrument or component:

handlin

] Equipment recycling. Production of this equipment required the extraction and
use of natural resources. The equipment may contain substances that could be
harmful to the environment or human health if improperly handled at the product’s
end of life. To avoid release of such substances into the environment and to
reduce the use of natural resources, we encourage you to recycle this product in
an appropriate system that will ensure that most of the materials are reused or
recycled appropriately.

This symbol indicates that this product complies with the applicable European
Union requirements according to Directives 2012/19/EU and 2006/66/EC

on waste electrical and electronic equipment (WEEE) and batteries. For
information about recycling options, check the Support/Service section of the
Tektronix Web site (www.tektronix.com).

il MTS4EAV7 Installation and Safety Instructions



Preface

The MTS4EA HEVC / AVC Video and Compressed Audio Analyzer is a powerful
real-time analytical tool for the investigation of compressed video and audio

data that has been encoded using the H.265/HEVC, H.264/AVC, H.264/SVC,
MPEG-1/2, MPEG-4 (including AAC and HE-AAC), VC-1, AC-3, and H.263
video standards.

The MTS4EA operates as a standalone software application for use on a personal
computer (PC) in a Windows environment. It can also be installed on Tektronix
MTS4000 MPEG Test Systems.

Product naming conventions

Although the order code for this product is MTS4EAV7, the product is generally
referred to as MTS4EA throughout the software and documentation.

User manual and tutorials

The information in this manual is also provided in the MTS4EA Help system
(press F1).

The PDF version of the MTS4EAV7 User Manual can be also accessed from
MTS4EA Help menu > User manual (PDF).

The PDF version of the user manual is provided:

B Because it is sometimes easier/clearer to navigate through a PDF document
than the standard Windows Help system

B So that you can easily print out additional copies of the manual
Tutorials are supplied as a separate PDF file accessible through the Help menu.

The PDF version of this manual and the tutorials are also on the installation
CD-ROM.

MTS4EAV7 Installation and Safety Instructions iii
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Software, hardware, and user prerequisites

This section lists the various software, hardware, and user prerequisites for
operating the MTS4EA software.

Windows operating system prerequisites

The MTS4EA software has been tested to run on the Microsoft Windows 7
operating system.

The MTS4EA software is not supported under any other operating system.

Audio playout prerequisites

In order to extract and play audio streams in the MTS4EA, the PC requires an
audio device, correctly configured.

Computer prerequisites

The MTS4EA software will work satisfactorily on relatively modest PC systems
(for example 800 MHz).

To decode and display CIF (Common Intermediate Format) video streams in real
time the following minimum PC configuration is recommended:

B Windows 7, 64-bit operating system
B Processor speed >2.5 GHz

B  Memory at least 4 GB RAM

®  Screen resolution at least 1024x768
B 250 GB minimum hard disk space

When writing trace information to the hard disk, the limiting factor is the speed of
the hard disk (regardless of the video standard), so the faster the better. Also, the
video and Trace files can be large (hundreds of MB) so a large hard disk is needed:

B Hard disk speed: at least - 7200 rpm

m  Hard disk size: as required for high-speed access to the video files to be
analyzed plus Trace information

MTS4EAV7 Installation and Safety Instructions 1



Software, hardware, and user prerequisites

Trace file writing/RAM disk

User prerequisites

The real limitation on speed is when the trace information is being written to disk.
This is the slowest operation; roughly 2 MB to 4 MB of data are written per video
frame for the more extensive trace functions. For H.265/HEVC video, if all of the
options are selected, 800 MB to 1 GB of data are written per video frame.

For most customers, this is not a problem, but if you want to have the highest
speed when playing video and writing the trace files, a RAM disk can be used.
This uses some of the system memory to emulate a disk drive.

There are several software products that offer this functionality; search on the
Internet for ‘RAM disk’.

If a RAM disk is used, a memory configuration of at least 512 MB is
recommended, with approximately 200 MB of RAM reserved for the RAM disk.
This would allow a 200 MB Trace file to be saved on the RAM disk.

The MTS4EA is sophisticated analysis software, which presents detailed
information relating to the video and audio standards.

It therefore assumes that you understand these audio and video standards in
significant detail and can therefore interpret the information presented by the
MTS4EA.

A list of references are provided in the MTS4EAV7 User Manual.

MTS4000 MPEG Test Systems

You can install version 7.0 and above of the MTS4EA software on Tektronix
MTS4000 Series MPEG test systems.

MTS4EAV7 Installation and Safety Instructions



Installation and licensing

This chapter describes the MTS4EA license type and the installation of the
MTS4EA software and license server.

License type

The MTS4EA software is provided with a floating license, which uses a software
key located on a license server or local machine to provide the license key.

This means that in order to run the MTS4EA software, you must have the
MTS4EA software key installed on the computer or server running the software.

NOTE. The software key is very important as it contains the MTS4EA license
and therefore embodies the value of the MTS4EA product. If the software key is
lost, you will have to purchase another software key, which may be at full list
price of the software.

All product options are visible in the installed MTS4EA menus. Options that are
not enabled by the license will be unavailable (grayed out). The status and scope
of the license can be checked at any time by clicking on the License manager
option in the Help menu.

License server  The floating license uses a software key located on a license server or local
requirements ~ machine to provide the license key.

Note the following system requirements:

B The software key will require a USB connection on the remote server or local
machine.

m  Ifinstalled on a remote server, a license server process must be run on the
server machine (this process has modest requirements for CPU load).

® Ifinstalled on a remote server, clients require TCP/IP access to the server (this
could be provided via VPN between remote sites).

MTS4EAV7 Installation and Safety Instructions 3



Installation and licensing

MTS4EA software installation

Install the license server

The MTS4EA software installer provides two setup choices: Local machine and
Remote server. If you are going to install the MTS4EA software on a remote
server, the server that is to host the license software must be set up first.

The MTS4EA floating license system enables a single software key (the DES
DK?2 dongle) to serve up licenses to multiple users connected over a network. The
software key is pre-programmed with licenses before shipment.

To install the floating license system on the network, you must:
B Install the DK2 Network Server software on a server (the license server).

®  On every client that is to use the floating license, install the MTS4EA software
that also installs the DK2 client software.

If you are going to install the MTS4EA software only on a local machine, proceed
to Install the MTS4EA software. (See page 6.)

A license server hosts the software key, which contains one or more licenses. It
is possible to have several license servers on the network, each with their own
software key, forming a pool of licenses for the clients to use. It is also relatively
easy to have a machine acting as both a server and a client.

To allow a machine to act as a license server, the following procedure should
be repeated on each machine:

1. Select a server machine and connect the software key (either via the USB port
or parallel port depending on software key type).

2. On the server machine, insert the MTS4EA installation CD.

NOTE. When the CD is inserted, the MTS4EA setup screen will be displayed.
Select the Close button at the bottom of the window to terminate the MTS4EA
installation program.

3. Using Windows Explorer, locate and open the DES directory. Run the
program named dnsrv32.exe. During the installation process, accept the
default entries.

4. Reboot the server machine if requested to do so at the end of the installation
process.

MTS4EAV7 Installation and Safety Instructions



Installation and licensing

5. Open the Control Panel (Windows Start > Settings > Control Panel) and select
the DESkey icon. This will show the DESkey Configuration dialog, the first
two tabs of which are shown in the following illustrations (note the version
numbers shown near the bottom may vary).

NOTE. For the server installation, the DK2/DK38 tab and the top half of the
Networking tab can be ignored; these refer to the client installation that shares
the same configuration dialog.

(@) DESkey Configuration I W X
DKZ / DK38 | Netwaorking | File Versions

Diriver Optionz

Enable Bi-Tronics Compatibilty Mode

Show window on ECP Activity

D38 Options

| [] Exclusive Mode
| Last DE.2 Yersion Found:  Mone Found
1

Access Method
| Search optionz ...
1

Enable Local DK.2 Access () Search Local First

Enable Metwork, DKZ Access @ Search Netwoark First

| 32bit DK.2 Properties Page Vergion 1.90.0.20

[ ok [ cCanced || ppy

<§> DESkey Configuration M
DK2 / DK38 | Networking | File Versions

Destination Servers for Clisnts on this machine

Machine Part

[ Manitar ][ E dit ][ Remayve ][ Add ]

DK.2 Network. Server service control

Service running

Start Server on system start
Server Port Mumber 3029

DK2 Metwarking Properties Page Version £.03.0.43

[ ok [ Canes Apply
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Installation and licensing

Install the MTS4EA
software

6. Select the Networking tab. The field at the bottom labeled Server Port
Number shows the port to be used for communication with any clients; the
default is 3029. Press the OK button to finish.

Depending on the policy of your IT department, port 3029 may be blocked

by the network firewall, in which case you will need to consult your network
administrator for another unrestricted port. Enter the new port and click the Apply
button. You may then get a prompt asking about restarting the server; select Yes —
this will stop and start the network server service using the new port. When the
port has been applied, press the OK button to finish. This does not cause the
server to reboot; it only restarts the license server.

If the MTS4EA is to be installed on a remote server, ensure that the following
information is available:

®  The network identity of the floating license server
B The server port number

These parameters are set up in the Install the license server section. (See page 4.)

7. Insert the MTS4EA installation CD.

NOTE. Ifthe installation process does not start automatically, run setup.exe from
the root directory of the installation CD.

8. At the bottom of the window showing the readme file, click the Install button
to start the installation.

9. Select the desired MTS4EA setup option.

| MTS4EA setup |

_ @ Wihere iz the MTS4EA Dongle attached?

* Local machine

" Remote server

a. Select OK to continue.
b. If you selected the Local machine option, proceed to step 14.

c. Ifyou selected the Remote server option, proceed to the next step.

MTS4EAV7 Installation and Safety Instructions



Installation and licensing

10. An initial dialog box is shown. Press Next. The DK2 software key driver
is installed.

NOTE. If you have installed the license server on this machine, launching the
client installation may show a dialog box titled DK2 Driver/Server Object that
asks if you want to start the DK2 Network Server - attach the software key and
select Yes.

11. At the end of the driver installation setup, a Network Configuration dialog
box will appear (shown below).

Metwork Configuration I.il—g_hj

Metwording

Desztination Servers for Clients on thiz machine

b achine Part

LA

b anitor Edit Remove | Add |

DE.2 Metwork, Server service control haz been dizabled:

The DE2 Metwork. Server service is not installed

Dk.2 Metworking Properties Page Yersion 6.03.0 43

DK | Cancel

12. This enables the server(s) installed in the previous section to be added to the
list of machines to query for licenses. If the required license server identity is
not already listed, select Add and enter the required license server network
identity and port number.

NOTE. If the DK?2 installer detects a previous installation of the DK2 driver on
this machine, the Network Configuration dialog box will not appear. In this
case, allow the installation to proceed and complete. After installation, open
the DESkey Networking Configuration dialog box (Windows Start > Settings >
Control Panel > DESkey > Networking tab) and proceed as described below.

MTS4EAV7 Installation and Safety Instructions 7



Installation and licensing

If you are installing the MTS4EA client software on the license server, the
server name to add is localhost. This is shown in the Networking Tab diagram
of the DESkey Configuration dialog box in the License Server section above.
The actual name of the machine can be used if preferred.

(é) DESkey Configuration Lll-g—hj
DK2 / DK38 | Networking | File Versions

Destination Servers for Clients on this machine

Maching Part

[ Manitar ][ Edit ][ Remaove ][ Add ]

DK2 Metwork Server service contral

Service running

Start Server on spstem start
Server Port Mumber 3029

D2 Metworking Properties Page Version B.03.0.43

oK ] [ Cancel Apply

NOTE. Changes made to the Server list on the Networking tab will only take
effect when the Apply button is pressed.

13. Add all the servers that are to be accessible to this client, and then press the
OK button to close the Network Configuration dialog box.

CAUTION. At this stage, depending on the history of the machine, a prompt may
ask to reboot. Select No, otherwise the MTS4EA installation will not complete
correctly and need to be rerun.

14. The MTS4EA installation will continue. When finished, reboot the machine.

8 MTS4EAV7 Installation and Safety Instructions



Installation and licensing

Test the license server  To ensure that the previous installations were successful, perform the following
steps:

15. If the MTS4EA software was installed on a remote server, remove any
Tektronix DK?2 software keys from the client machine and ensure the server
machine has a suitably programmed software key connected.

16. Run the MTS4EA application using the desktop icon. If it starts, the license
server is functioning correctly. If it does not start or displays the error
message “DESkey dongle failure. Please see the manual for troubleshooting
advice,” then check the following:

On the server machine, ensure the software key is inserted correctly and the
DK2 Network Server service is running. The latter can be checked by opening
the DESkey Configuration dialog box from the Control Panel. The Networking
tab shows the status of the service - if it is not running, then start it and try the
MTSA4EA application again.

Troubleshooting the license server

If the service will not start  Reboot the machine and try again. If it still does not work, it may be a faulty or
disabled port. For a USB software key, check the Device Manager for a DESkey
entry. (Open the Windows Control Panel, select the System icon, on the Hardware
tab click the Device Manager button. Any problem will show up as a yellow
triangle next to the DESkey entry.) For a parallel port software key, check that the
port is enabled in the machine's BIOS settings. Try a different port connection
if more than one is available.

It could also be a faulty software key, try connecting the software key to the client
machine and run the MT4EA software again (ensure the Enable Local DK2 Access
checkbox is selected in the DK2/DK38 tab of the DESkey configuration dialog
box). If this works, the software key is working, so try another server machine. If
this does not work, contact Tektronix Customer Support.

If the service starts but the = Check with the network administrator that the port being used is not being blocked
MTS4EA will not run by a firewall. If it is either get it unblocked or choose another port, changing it in
both the server and all clients; remember to press Apply in the associated dialog
boxes before closing them.

On the client machine, check the machine name entered in the client server list
is present and correct. If you entered it manually, try navigating to it using the
Browse feature to confirm that it is correct.

Check that the port number specified by the server is the same as the port number
specified in the client’s server list.

On the client machine, ensure the Enable Network DK2 Access checkbox is ticked
on the DK2/DK38 tab of the DESkey Configuration dialog.
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Installation and licensing
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How to use the MTS4EA

This section:
B Describes the elements of MTS4EA display window.
m  Tells how to start using MTS4EA display. (See page 12.)

®m  Summarizes the functions for each of the main menus. (See page 22.)

Window elements

Name of video or other loaded file B © MTS4EA - MPEG4 Example - Window Car - [Video View: MPEG4 Example - Window Car]

B4 E File Play Overlay Analysis Edit Alert Window Help - | & x
Main menu B E & 1w T = A KT Yl 2@
HEHALAA DD @ 8% W L0 & 23

Icon toolbars

Window area in which decoded or
other data displayed (HexView, Trace —f——————»
view, VBV view

Status bar —> Pause Al

Disabled: 0

NOTE. The above screenshot was taken with the MTS4EA running under
Windows XP.

In addition to the above toolbars/windows, there are multiple other toolbars that
are visible when particular functions are enabled. Also, there are some toolbars,
tooltips and menu items that are context-sensitive, depending on the video/audio
standard being used and/or the explicit function being performed.
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How to use the MTS4EA

Starting to use the MTS4EA

When the MTS4EA starts, the display initially looks as below:

12

@ MTS4EA

File Play Overlay Analysis Edit Alert Window Help

[Ez@a <t damprwmo o i 2@
BHEBAH= 2 G| /%l o 0 @7 28

Pause Al Disabled: 0

The gray background in the window indicates that no video or other files are
loaded. The only icons on the toolbar that are currently enabled are the icons:

®  For the Project (New Project [£], Open Project & and Save Project ﬂ)
®  Open stream =

= Help (]
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How to use the MTS4EA

NOTE. Some features on some menus may stay permanently grayed out
(unavailable). There are two possible reasons for this: the function or feature is
never enabled or is not relevant to the standard you are using; or the existing
license you have for MTS4EA does not allow all the features to be used - see
MTS4EA License Manager in chapter 4 for more information.

When menu items are grayed out, leaving the mouse at the location of the grayed
out menu item for a few seconds will display some popup text explaining why the
menu item is disabled and/or how it can be enabled. The following example is on
the Overlay menu, for the Blank video menu selection:

File Play Analysis Edit Alert Window Help
== N e R
HE

ME statistics

& Blank video
Open a video file to begin

All Disabled: 0

Blank out the video so that the overlay graphics are dearer

MTS4EAV7 Installation and Safety Instructions 13
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Opening a file

14

To open a file, do one of the following:
B Click on File > Open stream

®  Click the Open file icon =

m  Press Ctrl+O

When a stream is loaded, the first frame is decoded and displayed by the
MTS4EA. While the first frame of the stream is displayed, the stream itself is not
in Play mode, therefore Analysis options can be selected and configured.

In the following screenshot, the example file Beijing Girl is loaded with its first
frame displayed, but as indicated by the Stop icon and the empty frame counter in
the bottom right corner of the screen, the stream is yet to be played. Where there
is audio content, the audio waveform view is also displayed.

@ MTS4EA - Video View: MPEG4 File Example - Beijing Weather Girl

File Play Overlay Analysic Edt Alert Window Help

PEE@ oA a[mer o e e 4] E
EBLE = D &=
EELEFIEEED R
® Video View: MPEG4 File Example - Beijing Weat.... (= |[B] [T Audio Waveform View: MPEG4 File Example - Beijing Weather Girl N =E

+ - DRt [+ @l s e

Left Channel

£mpitude (normalised sample value)

ik 07 na na

[ B4 03 ba  na 05
Time (2)

Right Channel

mpliuce (normalised sample value)

148000 Hz |16 Bit

Disabled: 0

| al
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How to use the MTS4EA

If the loaded stream is initially advanced by one frame, the first frame is again
decoded/played before entering the Pause mode. In this mode, Analysis options
are not available. When stopped, the first frame reappears on the display until
the stream is advanced/played further.

@ MTS4EA - Video View: MPEG4 File Example - Beijing Weather Girl
Fie Play Overlay Analysis Edit Alert Window Help

e d & [T e
o E B oah B &
BEEABRHC B & &
3 Video View: MPEG4 File Example - Beijing Wex
+ - DR+ Q> Wl

____FEooool
Left Channel

T
=
T
H
n
3
E
=
A
-
3
o}
w
£
5
E
Iy
&
2
=

04 05
Time ()

Right Channel

ltude (narmalised sample valug)

A
2
48000 Hz 1661t

Al Disabled: 0 0001

As is normal with Windows applications, the window can be dragged around
within the frame of the application, resized, maximized, and minimized.

If another file is opened, then this replaces the file last opened; another window
is not opened.

NOTE. You can open several copies of the MTS4EA to allow direct, side-by-side
comparisons of multiple streams.
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Playing mode restrictions

16

MTS4EA projects

There are two Play modes: these are indicated at the lower left corner of the
status bar:

®  Stop: stream is stopped

m  Play: stream is paused (after Pause/Step forward) or playing at normal speed,
Fast forward, Blind, or Silent fast forward.

Certain actions can be performed only when the open file is in the appropriate
Play mode. A few such examples are:

B The Trace enable and Graph enable options on the Analysis menu are only
available in Stop mode.

B The real-time onscreen image overlays, such as MB types and motion vector
overlay do not update the video window when in Stop mode

NOTE. See the Audio/Video Synchronization section in the MTS4EAV7 User
Manual for further information and details on playing audio and audio-video
synchronization.

When working with the MTS4EA, the projects feature allows all current setups to
be saved at any point and reloaded, for example, to allow work to recommence
at exactly the same point. The project file includes information on the name of
the file being analyzed, the open views and the location of these, plus many
other items.
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Synchronized
views/navigating the
views

How to use the MTS4EA

When a video or audio stream is played, MTS4EA has many views of the video,

audio and other data:
m  Alert log

m  Video view

B Audio/video hex, stream edit and navigator views

®  Buffer analysis view

m  Fidelity view (for example PSNR analysis)

B Bits per frame view

®  Trace views

B Audio waveform, hex, alert, trace and stream edit views

®  File structure view

m  Excel graphs

Some of these views are linked. A right-click in one view will open a context
menu with a Goto command that will take you to the corresponding location in
another view (provided the file being played has both video and audio streams in
order to bring up the Audio waveform view).

Example of Goto view menus:

B video
Hex
iy Stream edit
4 alertlog
@ Video Navigator

|l Bits per frame
E Stream Structure

From Trace file

Hex
m& Stream edit
4 Alertlog
@ Video Navigator

E Trace
|l Bits per frame

[+ Audio waveform
A stream structure

From video view

NOTE. When in the video or audio view, to make it easier to see which area of
the window is providing the link to another view, there is always a small square
or rectangle in the view that highlights the MacroBlock/CTU or frame for

cross-referencing in the other view.

MTS4EAV7 Installation and Safety Instructions
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How to use the MTS4EA

Example of moving between views.

For example, when in the video view and

using the MacroBlock/CTU tooltip, to see the hex/binary data for a specific
MacroBlock/CTU, right-click at the MacroBlock/CTU location of interest and
select Goto view from the context menu, and then select the HexView. The
HexView window opens (if it is not already opened for this stream) and the first
byte of the selected MacroBlock/CTU is highlighted.

Selecting a specific byte in the HexView, and then using the right-click context
menu to select the Video view will take the video window to the MacroBlock/CTU
that contains the selected byte, with the MacroBlock/CTU highlighted. (See
page 18, Highlighting of selected areas in the video view.)

Highlighting of selected areas in the video view. If a data area is selected in a view
other than the video view, and the context menu is used to go to the video view,
the corresponding area of the video view is highlighted, as follows:

m If the area can be resolved to a single MacroBlock/CTU, then a yellow and
black dotted box is displayed around the MacroBlock/CTU concerned:

B MTS4EA - Video View: MPEG4 Example - Window Car
File Play Overlay Analysis Edit Alert Window Help

I G || 4

= &
B of

W Hex v ASCI Ao ~ | Bytes per line J r—_lrE'E‘

oololion
oiniioin
giioioon

01111010
io0ooo0ol
11100010

io0o0o010

oiniiion
oonoooil
10010110
io0ooiol
oinioion
i0i10io000
10110111
11101001
i0i100000
10111011
oloooool
11000011
oinioion
oiniooon
o01i1iiol
oooo11ol
11110000
10000011
oonioiil
io0ooo0ol
i00oo001
oilpooool
ooniiion
noooinon

10100!-'
10100010
ool11o010
11011001
10000001
oiiooo01l
10101101
00111101
10011100
ionooiol
10011100
1inooiol
10101010
ooio0i1iin
glooooon
00111010
oilnooiil
oilnooiil
10101000
0ini1ioil
10011010
oiniioon
10101010
10101010

10011110
11101000
in0i1o0lo00
10110000
iinooio00
11010000
niiiooon

ool1o1m

00101101 8

oonoioil
ooniiiin
o0i101iin
10100100
ooniooil
glooooon
11100101
glooloon
ooooooon
ooniiion
ooiooo01n
10101000
00111010
gooooion
oonlooon
10101010
10101101
ooiooiol
ooniioin
00111011

Address 0x24081 (147585) bit 1

MOTE: one/mare Alerts disabled Error Disabled: 0

18

MTS4EAV7 Installation and Safety Instructions



How to use the MTS4EA

m If the area cannot be resolved to a single MacroBlock/CTU, then a
yellow and black dotted rectangle is displayed surrounding the top row of
MacroBlocks/CTUs in the video frame that contains the first selected area:

1 MTS4EA - Video View: MPEG4 Example - Window Car
File Play Overlay Analysis Edit Alert

Window Help

CEX

Bl & <« bR o o voP || 4

B o

J0FOF 00000000
30F12 00010010
30F15 10000010
30F18 11101101
30F1B 11010010
J0F1E 00011100
30F21 01111111
30F24 01111010
30F27 00000001
30F24 11110000
30F20 01100000
30F30 11111000
30F33 00011010
30F36 11010010
30F39 00000011
F0F3C 00100110
30F3F 10011110
30F42 01000010

0

30F4E 01110001
30F51 11110101
30F54 00001001
30FS7 11000010
30F54 00001101
30FSD 01100010
30F6e0 00110010
30Fe3 11111000

2AEce 1Antntd

Selection: 0x30f45,7-0x30f49,5 35 bits

10010000
01001010
00101100
01010010
oo0i10iol
10101000
0i0io0iio
10000010
00101010
01001111
00011001
ooooi1iol
11100000
00010010
10011010
00111110
n01o0io00
n0ioo00l

noooo
10110110
10010111
ooo0io010
10011000
01100000
001o0io01
10010001
10100101
00111110

LGGGERREL

01oololo
oooio010
00110001
0iio0001
ni0oioo0
01111010
11000001
11101100
ooooioll
01010011
10101000
10101000
ooooioll
00110101
no011100
00111110
011001
10111¥10
ooooooon
11010111
11001110
01111010
oooioion
11100010
10101001
11110000
0il0oo01l
00011111

ERLGEGEE]

MOTE: one/mare Alerts disabled Errar Disabled: 0

B [f the selected area is in a frame or file header, not within a specific
MacroBlock/CTU, then a yellow and black dotted rectangle is displayed
surrounding the top row of MacroBlocks/CTUs in the video frame that
immediately follows the frame or file header (see the preceding illustration:
the data selected in the HexView window is in the VOP header, so the
highlight rectangle is displayed across the top row of MacroBlocks/CTUs
of the corresponding VOP).

Highlighting of selected areas in the audio view. Highlighting selected areas in the
audio waveform view works in a similar manner to highlighting areas in the video
view. (See page 18, Highlighting of selected areas in the video view.)

NOTE. An audio frame consists of a fixed number (per channel) of audio samples
representing a fixed time length of decoded audio. Typically each iteration
through the decode loop will output one audio frame of decoded audio.

MTS4EAV7 Installation and Safety Instructions
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Opening multiple windows

20

Synchronization of views/Synchronize views icon. 4 When the Synchronize

views icon 4" is pushed in, then all open windows automatically follow the
selection that you made.

For example, if the Video Navigator and Hex views are both open at the same
time as the Audio waveform view, and the Synchronize views icon is pushed in,
and video is then played, all views display the same relative points in the stream
at the same time.

NOTE. This can cause a delay when playing video for some views (such as the
Trace views) or when the memory buffers used by the MTS4EA do not contain all
the required data and therefore time is taken to decode and interpret the video

and refill the buffers.

Within the MTS4EA it is possible to open many windows at once. These can be:

B A video/audio window with another window, such as a HexView window
with a video window (as shown in the following figure):

3 MTS4EA - Hex: MPEG4 Example - Window Car
File Play Overlay Analysis Edit Alert Window Help

Pl @ e aam» oo o

[ 2| @]

L F:00105

¥ Bin ¥ Hex ¥ ASCI IAutu vl Bytes per Iine| Fres: Golo”U Absolute address

01000001 01001111 00000111 10110110 10001011 41
10000100 10101111 00000011 00101000 00101111
00010001 01001110 10101011 10111111 01010110
01011100 01100000 00001010 01100000 01011101
00001100 00000011 10101011 01111001 10101101
10001001 00111111 00000100 00010001 00100100
01001011 11111010 10011111 10010111 11111001
00110100 00010001 10100100 01000100 01111001
01011001 01111000 11111000 10111100 10111101
10100001 11111001 01110010 10001000 00100010
01111010 11100011 10000100 10110101 01010010
11001110 00101010 01010111 01111110 00000101
10000111 11100010 01000100 01010111 01000001
01010110 11100001 11111101 00011111 10101011
10101101 11111000 10111000 00011001 00000000
11110000 01100000 00001111 00000001 00000001
10011101 11111010 10111010 11010001 10100000
01000001 00000100 00111111 00010010 10000001
01001100 00010010 01001101 00010110 00110101

Address: 0x32283 (205443) bit 4

Error Disabled: 0

Ready MOTE: one/mare Alerts disabled

B Other combinations, such as the video/audio and HexView with the Trace file
view and file structure view.
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To open windows other than for video files (or files that contain video, such as
MP4 or 3GPP files, or MPEG-2 Program/Transport Streams):

B For Trace views, do one of the following:

- Select File > Open other (or click the icon E) to open a Trace file
previously stored or associated with another video stream

= Select Analysis > View trace (or Ctrl+V) to open the current trace file, as
named in the Analysis menu - Trace tab

B To view the statistical graphs (in Excel), click on Analysis > View graphs

B For HexView, click on Analysis > View stream hex (or click the icon
or press Ctrl+H)

B For the stream structure view, click on Analysis > View file structure (or
click the icon & or press Ctrl+R)

B For the buffer analysis view, click on Analysis > View buffer analysis (or

click the icon )
B For the fidelity analysis, click on Analysis > View fidelity analysis (or click
F
the icon ™)

= For the Alert Log, click on Alert > View alert log (or click the icon *)

= For the Audio waveform view, click on the icon ** . (If there is audio content,
the toolbar and the view will be displayed automatically when the video
view is opened.)

NOTE. The Audio waveform view is available only when an audio stream or
file/project containing an audio stream or streams is open.

®  For the multi-caption buffer view (closed caption analysis), click the tooltip

icon %
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Main menus

22

Functional summary for
each main menu

The submenu options available under each main menu selection (for example,
File, Play, Overlay) are described in detail in the MTS4EAV7 User Manual. A
summary of each main menu item is given here.

Several of the common functions can be accessed through the icon toolbars and

the Ctrl keys.

NOTE. You can open more than one copy of MTS4EA to allow direct, side-by-side
comparisons of multiple video streams.

Menu name Principal functions/suboptions

File Opening and saving files and projects, recent file list, example files, exit

Play Play video and audio, stop, pause, fast forward, set decoder options

Overlay Hide/show video/audio data and tooltips

Analysis Set Trace and Graph options; view Trace, Graph files, Hex view, file
structures, closed caption analysis, buffer analysis, fidelity analysis

Edit Edit elementary video/audio stream, edit bitstream selection, save
edited stream

Alert Enable/disable/configure overall alert levels and individual alerts

Window Arrange windows and toolbars, view settings, synchronize views,
window list

Help Help topics, PDF help and tutorials, license manager, version info
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BSD license

The copyright in this software is being made available under the BSD License,
included below. This software may be subject to other third party and contributor
rights, including patent rights, and no such rights are granted under this license.

Copyright (c) 2010-2013, ITU/ISO/IEC
All rights reserved.

Redistribution and use in source and binary forms, with or without modification,
are permitted provided that the following conditions are met:

B Redistributions of source code must retain the above copyright notice, this list
of conditions and the following disclaimer.

B Redistributions in binary form must reproduce the above copyright notice, this
list of conditions and the following disclaimer in the documentation and/or
other materials provided with the distribution.

m  Neither the name of the ITU/ISO/IEC nor the names of its contributors may
be used to endorse or promote products derived from this software without
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS

AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL

THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR

ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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